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M3. Modelação 2. 
1. Modificadores. 
 

 

 

 

 

 

Os  modificadores  são  operadores  que,  quando 
associados  a  um  objecto,  alteram  diversas  das  suas 
características, nomeadamente a sua forma, sem alterar 
a sua topologia  (número e posição dos vértices aresta e 
faces no caso de um objecto tipo malha), modificando o 
modo como o objecto é representado na janela 3D e/ou 
é renderizado. 

A  posteriori,  se  desejável,  os modificadores  podem  ser 
aplicados,  alterando  de  forma  permanente  a  topologia 
dos objectos.  

Na  figura  3.1  pode  ver  o  modelo  3D  de  uma  cabeça 
humana  com base numa malha de baixa resolução. 

Pode ver na figura 3.2 como, associando um modificador 
Subdivision  Surface  à  malha  do  modelo,  se  consegue 
melhorar  muito  significativamente  a  qualidade  da 
topologia  sem  qualquer  trabalho  de  modelação 
acrescido,  que  de  outro  modo  seria  terrivelmente 
demorado. 

Na  figura  3.3  pode  ver  o  resultado  da  aplicação  do 
modificador,  de  que  resulta  o  aumento  muito 
significativo  do  número  de  vértices  da  malha,  que  na 
verdade  correspondem  ao  conjunto  de  vértices 
necessários para se alcançar a melhoria da qualidade do 
modelo, mas que, enquanto o modificador apenas está 
associado  é  calculado  em  tempo  de  representação/ 
renderização,  mas  não  existem  em  tempo  de 
armazenamento. 

 

Figura 3.1 

 

Figura 3.2 

 

Figura 3.3 
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1.1. Add Modifier. [bpy.ops.object.modifier_add()] 
Para associar um modificador a um objecto previamente 
seleccionado, pressione o botão com o símbolo de uma 
chave  de  inglesa  existente  na  barra  da  Janela  de 
Propriedades,  figura  3.4,  accionando  assim  o  Contexto 
Modificadores. A janela de propriedades passa a mostrar 
o  painel  Modificadores,  figura  xxx,  de  onde  pode 
seleccionar o modificador desejado. 

 

 

 

 

 

Figura 3.4 

Falaremos  aqui  apenas  dos  modificadores  aplicáveis  a 
objectos do tipo malha no contexto da modelação. 

Seleccionado  um  modificador,  o  respectivo  painel 
passará  a  integrar  a  janela  de  propriedades  e  poderão 
ser especificados os seus parâmetros particulares. 

Praticamente todos os painéis apresentam um conjunto 
de opções que se mostram na figura 3.5. 

• À  esquerda,  o  pequeno  triângulo  permite 
colapsar  o  painel  do  modificador  deixando 
visível  apenas  o  seu  cabeçalho,  e  vice‐versa, 
figura 3.6. 

 

 

 

Figura 3.5 
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• Segue‐se o símbolo próprio do modificador e o 
respectivo nome padrão, editável pelo utilizador 
para uma mais fácil identificação. 

• O  botão  com  a  câmara,  quando  seleccionado, 
especifica que o modificador dever ser utilizado 
na renderização. 

•  O  botão  com  o  olho,  quando  seleccionado, 
especifica que o modificador dever ser utilizado 
na  representação  do  objecto  na  janela  3D  em 
modo objecto. 

• O  botão  com  o  cubo,  quando  seleccionado, 
especifica que o modificador dever ser utilizado 
na  representação  do  objecto  na  janela  3D  em 
modo edição (este botão não existir para alguns 
modificadores). 

• O botão com o triângulo, quando seleccionado, 
especifica  que  os  elementos  da  malha,  na 
representação  do  objecto  na  janela  3D  em 
modo  edição,  devem  ser  deslocados  para  a 
posição decorrente da aplicação do modificador 
(este  botão  não  existir  para  alguns 
modificadores). 

• Os  botões  com  os  pequenos  triângulos 
permitem,  caso  haja  um  conjunto  de 
modificadores  aplicados  ao  objecto,  designado 
por Stack, alterar a ordem de aplicação. 

• Pressionando o X o modificador é eliminado do 
stack, deixando de estar associado ao objecto. 

• O  botão  Copy  cria  um modificador  do mesmo 
tipo e coloca‐o na última posição do stack. 

• O botão Apply aplica o modificador ao objecto e 
retira‐o  do  stack  (para  que  tal  seja  possível  o 
modificador deve ser o primeiro do stack).  

Existindo  mais  do  que  um  modificador  associado  ao 
objecto, a ordem da sua aplicação, que pode ter bastante 
importância, é a de cima para baixo relativamente à sua 
posição no stack. 

No  exemplo  da  figura  3.7  o  modificador  Subsurf  é  o 
primeiro  a  ser  aplicado,  seguindo‐se  a  aplicação  do 
modificador Bevel. Desta ordem de  aplicação  resultaria 
para um  cubo o objecto da  figura 3.7 à esquerda. Se a 
ordem de aplicação fosse a inversa resultaria o objecto à 
direita na mesma figura. 

Sempre  que  é  associado  um  novo  modificador  este  é 
colocado na posição mais baixa do stack. 

 

Figura 3.6 

 

Figura 3.7 
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1.2. Mirror. 
Quer  em  modo  objecto  que  em  modo  edição,  o 
modificador  Mirror,  figura  3.8,  reflecte  uma  malha 
relativamente  aos planos  coordenados do  seu  sistemas 
de eixos local, tendo o centro (origem) do objecto como 
pivot,  ou  relativamente  aos  planos  coordenados  do 
sistema de eixos  local de um qualquer objecto,  tendo o 
centro desse objecto como pivot. 

É muito  comum que os objectos a modelar exibam em 
alguma  sua  parte,  ou  no  todo,  qualquer  espécie  de 
simetria.  

Para  simetrias  radiais  vimos no Módulo 2  como utilizar 
convenientemente  a  função  Spin.  Para  simetrias 
relativamente  a  um  plano,  como  é  o  caso  do  corpo 
humano,  dos  animais  em  geral,  e  da maior  parte  das 
máquinas  e  utensílios,  podemos  recorrer  à  função 
Mirror,  também vista no Módulo 2, para, após modelar 
uma  das metades,  produzir  e  seu  duplicado  no  final,  e 
assim o objecto completo. 

Para  tornar  mais  intuitiva  a  criação  do  objecto,  entre 
outras  razões,  é  preferível,  no  entanto,  recorrer  ao 
modificador mirror, que permite a progressiva criação do 
objecto no  seu  todo, embora o  trabalho de edição  seja 
feito apenas numa das suas partes. 

1.2.1. Parâmetros 

• Merge  Limit.  Distância  máxima  ao  plano  de 
reflexão abaixo da qual um vértice se funde com 
a sua imagem. 

• Axis. Eixo, do sistema local do objecto, ao longo 
do  qual  se  dá  a  reflexão,  ou  seja,  eixo 
perpendicular  ao  plano de  reflexão  (que  passa 
pelo  centro  do  objecto),  podendo  ser 
seleccionado  mais  do  que  um,  dando  assim 
origem a múltiplas cópias. 

• Options. 
o Clipping.  Quando  seleccionado,  e  em 

modo  edição,  os  vértices  não 
ultrapassam o plano de reflexão, o que 
normalmente é desejável. 

o Vertex  Groups.  Quando  seleccionado, 
as  imagens de  vértices pertencentes a 
grupos  de  vértices  existentes  no 
objecto dão origem a grupo reflectidos. 
  

 

Figura 3.8 
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• Textures. Relevante quando exista texturas com 
mapeamento  UV  sobre  o  objecto,  passando, 
quando  seleccionada  a  coordenada,  a  ser 
reflectida em torno de 0.5. Isto é, por exemplo, 
a imagem de um vértice que tenha coordenadas 
UV (0.2, 0.7) passará a ter coordenadas UV (0.8, 
0.3),  e  não  as  coordenadas  UV  do  vértice 
original. 

• Mirror Object. Nome do objecto cujo referencial 
local será utilizado como referencial de reflexão. 
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1.3. Tutorial 4 
Vamos  exemplificar  a  modelação  simétrica  recorrendo 
ao modificador Mirror construindo de novo o modelo 3D 
de um peão de xadrez. Vamos adoptar uma estratégia de 
modelação Bottom‐Up  a  partir  de  um  único  vértice. O 
exemplo  serve  ainda  para mostrar  como  inserir  figuras 
nos  alçados  principais,  de modo  a  guiar  o  processo  de 
modelação.  

1. Abra o ficheiro Blender do tutorial 1 ou 2 e salve uma 
imagem  (faça uma  captura de ecrã) do peão de  xadrez 
numa  projecção  ortogonal  em  frontview  e  outra  em 
topview. 

2.  Abra  um  novo  Blender.  Deixe  estar  o  cubo.  Vamos 
utilizá‐lo  para  centrar  e  escalar  as  figuras  a  inserir  nos 
alçados principais. 

3. Pressionando [Ctrl]+[Alt]+[Q], para evocar o modo de 
visualização Quad View. 

4. Abra a tabela de propriedades, [N]. Seleccione a tabela 
Background  Images.  Active  Background  Images. 
Pressione  Add  Image,  Not  Set  e  Open.  Seleccione  o 
ficheiro com a imagem do peão em front view. No menu 
Axis seleccione Front. 

5.  Pressione  de  novo  Add  Image,  Not  Set  e  Open. 
Seleccione  o  ficheiro  com  a  imagem  do  peão  em  front 
view. No menu Axis seleccione Right. 

6.  Pressione  de  novo  Add  Image,  Not  Set  e  Open. 
Seleccione  o  ficheiro  com  a  imagem  do  peão  em  top 
view. No menu Axis seleccione Top. 

7. Passe a modo de sombreamento Wireframe. Na janela 
Front Ortho,  ajuste  a  dimensão  do  cubo  à  imagem  do 
peão, procedendo a escalamentos do cubo em zz e xx, e, 
editando as caixas X e Y da tabela de propiedades, painel 
Background  Images,  subpainel Axis:  Front,  figuras 3.9 e 
3.10. Eventualmente, para obter maior rigor, poderá ter 
de  maximizar  a  janela  Front  Ortho,  para  isso  basta 
comutar o modo Quad View, [Ctrl]+[Alt]+[Q]. 

8.  Passe  agora  à  janela  Top  Ortho.  Como  pode  ver,  a 
dimensão do cubo segundo yy é diferente da dimensão 
segundo  xx.  Na  tabela  de  propriedades,  painel 
Transform,  edite  o  escalamento  segundo  yy,  dando‐lhe 
um  valor  igual  ao  existente  segundo  xx  devido  ao 
escalamento feito no ponto anterior, figura 3.11. 

 

Figura 3.9 

 

Figura 3.10 

 

Figura 3.11 
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9. Observando a  janela Top Ortho, ajuste a  imagem do 
peão  às  dimensões  do  cubo  recorrendo  à  tabela  de 
propriedades, painel Background Images, subpainel Axis: 
Top, caixa Size, figuras 3.12 e 3.13. 

10.  Observe  agora  a  janela  Right  Ortho.  Na  tabela  de 
propriedades, painel Background Images, subpainel Axis: 
Right, edite  as  caixas X e Y de modo a  centrar  a  figura 
(neste  caso,  basta  dar‐lhes  os  mesmos  valores  das 
respectivas caixas do subpainel Front. 

Neste  momento  deve  ter  as  imagens  completamente 
enquadradas no cubo. 

Dada  a  simplicidade  da  figura  do  peão  de  xadrez,  e 
porque se  trata de uma  figura de  revolução, alguns dos 
procedimentos  aqui  descritos  são  completamente 
irrelevantes no trabalho de modelação que se segue. No 
entanto,  a  fase,  acima  descrita,  de  centragem  e 
escalamento  das  imagens  em  cada  um  dos  3  alçados 
principais é  fundamental para a progressão do  trabalho 
de  modelação.  Voltaremos  ao  assunto  para  modelos 
mais complexos. 

 

11. Seleccione o cubo e entre em modo edição, [Tab]. 

12. Desseleccione todos os vértices, [A].  

13.  Seleccione  os  4  vértices  da  base,  [RMB], 
[Shift]+[RMB].  

14.  Coloque  o  cursor  3D  no  centro  dos  4  vértices, 
[Shift]+[S] > Cursor to Selected, figura 3.14. 

15. Saia de modo edição, [Tab]. 

16. Coloque a origem do objecto sobre o cursor 3D, barra 
da janela 3D: Object > Transform > Origin to 3D Cursor. 

17. Entre em modo edição, [Tab]. 

18. Seleccione todos os vértices, [A] > [A], e elimine‐os, 
[X] > Vertices. 

19. Na  janela  Top Ortho,  crie  um  vértice  no  centro  da 
base  do  peão,  [Ctrl]+[LMB].  Corrija  a  sua  posição  na 
janela  de  propriedades,  painel  Transform,  Vertex:  [0.0 
0.0 z]. 

 

Figura 3.12 

 

Figura 3.13 

 

Figura 3.14 
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20.  A  partir  de  um  vértice  inicial,  crie  um  triângulo  na 
base do peão,  [Ctrl]+[LMB],  [Ctrl]+[LMB],  [Shift]+[MRB] 
sobre o primeiro vértice e [F] para criar uma aresta entre 
os dois últimos vértices, figura 3.15. Seleccione cada uma 
dos  vértices  e  ajuste  a  sua  posição  no  painel  de 
propriedades. 

 

 

 

 

21.  Seleccione  a  aresta  exterior  e  subdivida‐a  em  8 
partes,  [W]  >  Subdivide,  e,  no  painel  de  operadores, 
Number of Cuts : 7, figura 3.16.  

 

 

 

 

 

22. Desactive os vértices criados,  [A], e active apenas o 
vértice  central,  [MRB]. Active  a  edição proporcional de 
vértices,  [O],  seleccione  o  modo  Sphere,  a  partir  do 
menu  da  barra  da  janela  3D  ou  pressionando 
sucessivamente [Shift]+[O], estenda a zona de influência 
a todos os vértices da aresta exterior com excepção das 
extremidades,  [MW],  e  arraste  o  vértice  seleccionado, 
aa,  até  ao  perímetro  exterior  da  base  do  peão,  figura 
3.17. 

 

 

23. Seleccione todos os vértices, [A], e crie um conjunto 
de faces, [Alt]+[F] ou Mesh > Faces > Fill, figura 3.18. 

 

Figura 3.15 

 

Figura 3.16 

 

Figura 3.17 

 

Figura 3.18 
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24.  Na  janela  de  propriedades,  accione  o  contexto 
modificadores e associe um modificador Mirror à malha. 
Seleccione o eixo dos yy e active Clipping, figura 3.19. 

145 
 

25.  Seleccione  apenas os  vértices exteriores,  [Shift]+[Z] 
sobre o vértice central, e  faça uma extrusão segundo zz 
até  ao  1º  patamar  do  peão,  [E]>[Z]  (na  janela  Front 
Ortho). 

26. Faça uma nova extrusão até ao 2º patamar e outra 
até ao 3º patamar, [E]>[Z]. 

27.  Coloque  o  cursor  3D  na  origem,  [RMB]  sobre  o 
vértice central e [Shift]+[S] > Cursor to Selected.   

Figura 3.19 
28. Na barra da janela 3D seleccione como Pivot Point o 
cursor 3D. 

29. Faça um escalamento no plano xy, [E]>[Shift]+[Z].  

30.  Prossiga  com  as  operações  extrusão  segundo  zz  e 
extrusão segundo zz seguida de escalamento no plano xy 
até completar todo o peão, figura 3.20. 

31. Chegando ao topo, faça uma extrusão sem mover os 
vértices criados, [E] > [LMB], e arraste‐os até ao centro, 
[G] > [Shift]+[Z], de modo a colapsalos num só. 

 

 

 

 

 

   

Figura 3.20  
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1.4. Subdivision Surface. 
O modificador SubSurf,  figura 3.21, utiliza um algoritmo 
de subdivisão de superfícies para determinar um modelo 
da alta resolução a partir de uma malha com um número 
relativamente  reduzido de  vértices, podendo  ser usado 
quer  durante  a  fase  de  modelação  quer  durante  o 
processo de renderização.  

As vantagens da aplicação do modificador são óbvias ao 
nível  do  tempo/esforço  do  processo  de  modelação, 
compare a figura 3.22 com a figura 3.23 que resulta da 1ª 
após  a  associação  do  modificador,  sendo  também 
relevantes  a  nível  da  quantidade  de  informação  que  é 
necessário armazenar. 

1.4.1. Parâmetros 

• Catmull‐Clark/Simple. Tipo e algoritmo utilizado 
na subdivisão das superfícies. 

o Catmull‐Clark subdivide as superfícies e 
altera  a  posição  de  cada  um  dos 
vértices, dando ao modelo um aspecto 
orgânico de transições suaves. 

o  Simple  limita‐se  a  fazer  a  subdivisão 
de  cada  uma  das  superfícies 
(equivalente à função subdivide). 

• Subdivisions. Nível de subdivisão utilizado. 
o View.  Nível  de  subdivisão  utilizado 

durante no processo de modelação.  
o Render.  Nível  de  subdivisão  utilizado 

durante o processo de renderização. 
• Options. 

o Optimal  Display.  Comuta  entre  a 
representação  total  da  malha 
resultante  da  subdivisão  e  a 
representação  apenas  do  conjunto  de 
vértices originais. 

o Subdivide UVs. Quando activado, força 
o Blender, no contexto da texturização 
UV,  a  calcular  as  coordenadas  UV  de 
todos os vértices virtuais. 

Note que o número de faces criadas, 4n por cada quad e 
3x4n‐1  por  cada  face  triangular  (sendo  n  o  nível  de 
subdivisão),  aumenta  dramaticamente  o  número  de 
vértices  a  ser  processado,  pelo  que  não  é  conveniente 
utilizar em modo edição um nível  subsurf  superior  a 2, 
que produz já excelentes resultados, figuras 3.22 a 3.24. 

 

Figura 3.21 

 

Figura 3.22 

 

Figura 3.23 

 

Figura 3.24 
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1.4.2. Edge Crease. [bpy.ops.transform.edge_crease()]. 
Tabela de 
Operadores  Shortcut  Menu  Barra 3D 

    [Ctrl]+[E]   

Edge Crease  é  evocável  a partir da barra da  janela 3D, 
[Mesh>Eges>Edge  Crease],  e  a  partir  do  menu  Edge 
Special, [Ctrl]+[E]. 

Seleccionada uma aresta e evocada a função, o nível do 
vinco é controlável pela distância do rato à aresta ou por 
edição  directa  do  parâmetro  na  caixa  Crease  do  painel 
Transform da tabela de propriedades, figura 3.26. 

As  arestas  em  que  o  valor  Crease  foi  modificado,  o 
parâmetro  assume  valores  entre  0.0  e  1.0,  ficam 
assinaladas a magenta, sendo a representação comutável 
no painel Mesh Display da tabela de propiedades, figura 
3.27. 

Edge  Crease  é  uma  função  directamente  associada  à 
utilização  do  modificador  Subdivision  Surface,  e  que 
permite controlar a força com que cada uma das arestas 
atrai  a  malha  da  alta  definição,  isto  é,  se  a  transição 
entre faces de dá de modo mais suave ou mais brusco. 

Na figura 3.28 à esquerda pode ver um cubo subdividido 
a que  foi associado um modificador subdivision surface. 
Como  pode  ver,  o  cubo  passou  a  ter  uma  forma 
arredondada, tendo desaparecido as arestas vivas. 

Na  mesma  figura,  à  direita,  pode  ver  o  resultado  da 
aplicação  de  Edge  Crease  às  arestas  do  contorno 
superior, que passaram a formar um conjunto de aresta 
vivas na transição para a superfície lateral  do cubo. 

Nota: Embora seja bastante prático, o parâmetro Crease 
associado a uma aresta não é um standard no universo 
das  ferramentas  de  modelação  3D,  pelo  que  não  é 
possível exportar a informação para outras aplicações. 

Alternativamente,  com  o  objectivo  de  criar  vincos  em 
modelos de transições suaves, é bastante mais comum a 
técnica  de  criação  de  contornos muito  próximos.  Pode 
ver  na  figura  3.29  o mesmo  resultado  final  conseguido 
através da utilização das duas técnicas. 

 
 
 

 

Figura 3.25 

 

Figura 3.26 

 

Figura 3.27 

 

Figura 3.28 

 

Figura 3.29 
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1.5. Tutorial 5 
1. Abra o ficheiro Blender do tutorial 4. 

2. Seleccione o peão de xadrez,  [RMB]. Entre em modo 
edição,  [TAB].  Na  janela  de  propriedades  seleccione  o 
contexto  modificadores  e  associe  ao  peão  um 
modificador do tipo Subdivision Surface. 

3.  Aumente  o  parâmetro  Subdivisions/View  para  2  e 
pressione  o  botão  com  o  triângulo  invertido  para 
deslocar  os  elementos  da  malha  para  a  posição 
decorrente da aplicação do modificador. 

4.  Na  tabela  de  operadores  (caso  não  esteja  visível 
pressione  [T])  active  Shading:  Smooth.  Deve  ter  neste 
momento uma malha idêntica à da figura 3.30. 

 

5.  Seleccione  um  dos  vértices  da  base  e  accione  Loop 
Cut,  [Ctrl]+[R], de modo  a  inserir um  contorno  entre  a 
base e o 1º patamar, figura 3.31. 

 

 

 

6.  Confirme  a  posição  do  contorno,  [LMB],  arraste‐o  o 
mais possível em direcção à base do peão, e confirme a 
posição, figura 3.32. 

 

 

 

 

7.  Seleccione um dos  vértices do 1º patamar e accione 
Loop  Cut,  [Ctrl]+[R],  de  modo  a  inserir  um  novo 
contorno, figura 3.33. 

 

 

 

Figura 3.30 

 

Figura 3.31 

 

Figura 3.32 

 

Figura 3.33 
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8.  Confirme  a  posição  do  contorno,  [LMB],  arraste‐o  o 
mais possível em direcção ao contorno do 1º patamar, e 
confirme a posição, figura 3.34. 

Inserimos assim duas arestas vivas, uma na base e outra 
no 1º patamar. A malha deve agora  ter a  forma que se 
mostra na figura 3.35. 

Bastaria agora associar materiais, inserir as fontes de luz 
consideradas  adequadas,  e  proceder  à  renderização.  A 
figura  3.36 mostra  um  exemplo  do  que  poderia  ser  o 
resultado final obtido. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 3.34 

 

Figura 3.35 

 

Figura 3.36 
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1.6. Array. 
Seleccionado  um  objecto,  o modificador Array  cria  um 
vector  de  cópias  segundo  uma  qualquer  direcção  do 
espaço 3D e um qualquer  espaçamento,  resultantes da 
configuração dos parâmetros do modificador. 

A  duplicação  segundo  diversa  direcções  resulta 
facilmente do empilhamento de diversos modificadores 
no stack. Por exemplo, o objecto da figura xxx, é criado a 
partir de um cubo, associando‐lhe um sequência de três 
modificadores  Array,  que  criam,  o  1º,  duas  cópias 
segundo  xx,  o  2º,  uma  cópia  segundo  yy  e,  o  3º,  três 
cópias segundo zz. 

1.6.1. Parâmetros 

• Fit Type. Determina o modo como o número de 
cópias é calculado. 

o Fixed  Count.  O  número  de  cópias 
resulta  do  parâmetro  Count,  que 
especifica o número total de elementos 
do  vector,  isto  é,  número  de  cópias 
mais 1. 

o Fit  Length.  É  especificada  uma 
dimensão  máxima  (BU)  do  vector, 
Length,  e  são  geradas  tantas  cópias 
quantas  as  que  couberem  nesta 
dimensão. 

o Fit  Curve.  São  geradas  tantas  cópias 
quantas a que  couberem na dimensão 
de  um  objecto  do  tipo  Curve, 
especificado  pelo  nome  no  parâmetro 
Curve. 

• Constant  Offset.  O  centro  de  cada  uma  das 
cópias é transladado de uma distância constante 
(BU) relativamente ao centro da cópia anterior, 
segundo  cada  um  dos  eixos  coordenados, 
conforme especificado nas respectivas caixas. 

• Relative  Offset.  O  centro  de  cada  uma  das 
cópias  é  transladado  de  uma  distância  igual  à 
dimensão da bounding box do objecto original 
multiplicado  por  um  factor  segundo  cada  um 
dos  eixos  coordenados,  conforme  especificado 
nas respectivas caixas. 

 

 

Figura 3.37 

 

Figura 3.38 

 

Figura 3.39 

 

Figura 3.40 
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• Object  Offset.  Cada  uma  das  cópias  sofre, 
relativamente  à  anterior,  o  conjunto  de 
transformações idêntico ao sofrido pelo objecto 
especificado  na  respectiva  caixa.  Por  exemplo, 
na  figura  3.41,  pode  ver  o  resultado  da 
construção  de  12  cópias  construídas  com base 
num Object Offset associado a um objecto que 
foi transladado rodado e escalado. 

• Merge.  Quando  seleccionado,  os  vértices  de 
cada  cópia  são  ligados  aos  vértices  da  cópia 
anterior  que  estejam  aquém  de  um  raio 
especificado em Distance. 

o First  Last.  Quando  seleccionado, 
conjuntamente  com  Merge,  força  a 
ligação  entre  os  vértices  da  1ª  a  de 
última  cópia  (tendo  também  em 
atenção o parâmetro Distance). 

• Start/End  Cap.  Permite  a  especificação  de 
objectos a colocar  imediatamente ante da 1ª e 
depois  da  última  posição  do  array.  Se Merge 
estiver  seleccionado  os  objectos  serão  ligados 
ao elementos do array. 

 

Figura 3.41 

 

Figura 3.42 
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1.7. Tutorial 6 
1. Abra o Blender. Seleccione o cubo, [MRB], e entre em 
modo edição, [Tab].  

2.  Na  configuração  padrão  todos  os  vértices  estão 
seleccionados. Desseleccione todos os vértices, [A]. 

3. Seleccione os 4 quatro vértices de uma das  faces do 
plano  xz,  [MRB]  e  [Shift]+[MRB],  e  elimine  a  face,  [X], 
figura xxx.  

4. Procedendo de modo idêntico elimine a outra face do 
plano  xz,  obtendo  assim  o  objecto  que  se  mostra  na 
figura 3.44. 

5. Caso lá não esteja, coloque o cursor 3D sobre a origem 
do objecto, [Shift]+[S] > [Cursor to Center]. 

6. Saia de modo edição, [Tab]. 

7. Insira um objecto do tipo Empty. [Shift]+[A] > [Empty]. 

8. Seleccione o cubo, [MRB]. Na  janela de propriedades 
seleccione  o  contexto  Modificadores  e  insira  um 
modificador do tipo Array, figura xxx. 

9. Altere Count para 25.  

10.  Desseleccione  Relative  Offset  e  seleccione  Object 
Offset. 

11.  Pressione  a  caixa  do  objecto,  [MLB]  e  seleccione 
Empty. 

12. Seleccione Merge e altere Distance para 1. 

13. Seleccione o Empty. Caso tenha dificuldade por estar 
meio obstruído pelo cubo, pode seleccioná‐lo facilmente 
a partir da janela Esquemático. 

14.  Com  o  rato  sobre  a  janela  3D,  pressione  [N]  para 
expor a tabela de propriedades. 

15.  Translade  o  Empty,  colocando‐o  no  ponto  [0.0  2.0 
0.7], rode‐o 18o segundo xx e 20o segundo zz e escale‐o 
de  um  factor  0.9  segundo  cada  uma  dos  eixos 
coordenados. Para isso edite directamente as respectivas 
caixas do painel Transform, figura 3.46. 

 

 

Figura 3.43 

 

Figura 3.44 

  

Figura 3.45 
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Obtemos assim 24 cópias do cubo, sucessivamente mais 
pequenas, rodadas e trasladas, como se mostra na figura 
3.47. 

 

 

 

Figura 3.46 

 

Figura 3.47

16.  Com  o  cubo  seleccionado  associe‐lhe  agora  um 
modificador do tipo Mirror, desseleccione X e seleccione 
Z  para  reflectir  o  objecto  relativamente  ao  plano  XY, 
figura 3.48. 

Deve  neste momento  ter  o  objecto  que  se mostra  na 
figura 3.49. 

 

 

 

 

Figura 3.48 

 

Figura 3.49 
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17.  Caso  lá  não  esteja,  coloque  o  cursor  3D  sobre  a 
origem do objecto, [Shift]+[S] > [Cursor to Center]. 

18.  Insira  um  objecto  do  tipo  Empty.  [Shift]+[A]  > 
[Empty]. 

19.  Seleccione  o  cubo,  [MRB].  Insira  um  novo 
modificador do tipo Array, figura 3.50. 

20.  Desseleccione  Relative  Offset  e  seleccione  Object 
Offset. 

21.  Pressione  a  caixa do  objecto,  [MLB]  e  seleccione  o 
novo  Empty,  que,  provavelmente,  tem  o  nome, 
Empty.001. 

22. Seleccione Merge e altere Distance para 1. 

23. Seleccione o novo Empty.  

24. Translade o novo Empty, colocando‐o no ponto [0.0 ‐
2.0 0.0], rode‐o 90o segundo yy e 180o segundo zz. Para 
isso  edite  directamente  as  respectivas  caixas  do  painel 
Transform, figura 3.51. 

Deverá neste momento  ter o objecto que  se mostra na 
figura 3.52. 

 

Figura 3.50 

 

 

 

 

Figura 3.51 

 

Figura 3.52 
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25. Finalmente, com o cubo seleccionado associe‐lhe um 
modificador  do  tipo  Subdivision  Surface.  Altere  o 
parâmetro  View  e  o  parâmetro  Render  para  3,  figura 
3.53. 

Deverá neste momento  ter o objecto que  se mostra na 
figura 3.54. 

Bastaria agora associar materiais, inserir as fontes de luz 
consideradas  adequadas,  e  proceder  à  renderização.  A 
figura  3.55 mostra  um  exemplo  do  que  poderia  ser  o 
resultado final obtido. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 3.53 

 

Figura 3.54 

 

Figura 3.55 
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1.8. Displace. 
O modificador Displace,  figura 3.56, desloca os vértices 
de uma malha com base numa textura. 

1.8.1. Parâmetros 

• Texture.  Nome  da  textura  em  que  se  deve 
basear o deslocamento dos vértices. 

• Vertex Group. Nome do grupo de vértices que é 
utilizado  para  controlar  a  influência  do 
modificador. Se não especificado, o modificador 
actua  igualmente  sobre  todos  os  vértices  da 
malha. 

• Direction.  Direcção  segundo  a  qual  é  feito  o 
deslocamento  dos  vértices  da  malha.  Figura 
3.57. 

o RGB  to  XYZ.  Segundo  cada  um  dos 
eixos  conforme  a  informação  de  cada 
um dos canais de cor. 

o Normal.  Segundo a normal a  cada um 
dos vértices. 

o Z. Segundo o eixo dos zz do sistema de 
eixos local. 

o Y. Segundo o eixo dos yy do sistema de 
eixos local. 

o X. Segundo o eixo dos xx do sistema de 
eixos local. 

• Texture  Coordinates.  Sistema  de  coordenadas 
que determina a associação da textura à malha. 
Figura 3.58. 

o UV.  Deslocamento  conforme  com  o 
mapeamento  UV  da  textura  sobre  a 
malha. 

o Object. Sistema de  coordenadas  locais 
do  objecto  especificado.  Se  não 
especificado  é  considerado  o  sistema 
de eixos local da malha a que está a ser 
aplicado  o  modificador.  Nota:  A 
associação a um qualquer objecto é útil 
em  animação,  já  que  a  uma 
modificação    da  posição  relativa  dos 
objectos  tem  consequências  no 
deslocamento  provocado  pelo 
modificador. 

o Global. Sistema de coordenadas global. 
o Map. ? 

 
 

 

Figura 3.56 

 

Figura 3.57 

 

Figura 3.58 
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• Midlevel. Valor da cor, em [0.0 1.0], e não em [0 
255], a que corresponde um deslocamento nulo 
dos  vértices.  A  valores  abaixo  de  Midlevel 
corresponde  um  deslocamento  em  sentido 
negativo  ao  especificado  em  Direction,  e  a 
valores  acima  um  deslocamento  em  sentido 
positivo. 

• Strength.  Factor  multiplicativo  do 
deslocamento. 

No  módulo  Texturas  encontrará  tutoriais 
exemplificativos da utilização deste modificador. 
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